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Preface
The documentation set consists of the HP Easytime/XL User’s Guide, an online help
system, and a Quick Reference Guide.

The manual is organized as follows:

Chapter 1 , “Introduction,” Describes the purpose and intended audience of
HP Easytime/XL and explains starting of a localized version.

Chapter 2 , “Getting Started,” Describes how to start HP Easytime/XL and the basic skills
needed to use the product effectively.

Chapter 3 , “HP Easytime/XL Tasks,” Describes all the tasks needed to monitor and
manage; printing files, jobs, sessions, console messages, and backups of the system. The
section also describes how the system administrator can customize HP Easytime/XL with
the setup program.

Chapter 4 , “HP Easytime/XL Reference,” Provides information about console messages
and requests, error messages, keys, default options, field and screen descriptions, and
wildcard characters.
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Audience
The primary audience for this manual is both the system administrator and the end user
of the HP e3000 computer. The “Customizing HP Easytime/XL” section is intended for the
system administrator only.

Online Help Facility
Provides an extensive online help facility that includes step-by-step instructions for all
tasks, field definitions, and overview of basic skills and concepts needed to use the product
effectively, and a complete glossary of terms and definitions.

Quick Reference Card
Provides a quick reference for important skills and tasks.
14



1 Introduction
HP Easytime/XL is a program used to communicate with the HP e3000
computer. Menus guide you through managing system resources,
printing reports, or sending messages to another user on the same
system.

Whether you are the system administrator, managing the system as
your primary job responsibility, or an end-user, using the system
occasionally to print a file, HP Easytime/XL can be used efficiently and
productively to meet individual work needs.

The following list is some of the tasks that can be performed with
HP Easytime/XL:

• Print, copy, rename, delete, and store files

• Review and manage files waiting to be printed

• Start, schedule, and delete jobs

• Show and delete sessions

• Send messages to other users

• Review messages and reply to requests from the system

• Perform full and partial backups

• Sort and display information to meet special needs

• Access an extensive online help facility
15
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Starting a Localized Version of
HP Easytime/XL
In addition to English, there are four localized versions of
HP Easytime/XL; French, Spanish, German and Japanese. If installing
one of the localized versions, the system manager must configure the
appropriate language on your system using the LANGINST utility
program. Refer to Localizing/Customizing System Information for the
LANGINST dialog.

Refer to Table 1-1, it indicates the commands to be typed to start a
localized version of HP Easytime/XL. Please note that this setting is
valid for the current session only. If the system administrator has
specified the language of the localized version as the system default
language, this procedure does not need to be performed.

For example, to set the session to French:

1. Type :SETJCW NLUSERLANG=7Return

2. Type :RUN EASYTIME.PUB.SYS Return

A message appears in French prompting you to enable
HP Easytime/XL. If this message is displayed in English, the system
administrator has not configured French for your system.

3. Press F5 OK to enable HP Easytime/XL.

Table 1-1 Language Settings

For This Language Type This

French SETJCW NLUSERLANG=7 Return

Spanish SETJCW NLUSERLANG=12 Return

German SETJCW NLUSERLANG=8 Return

Japanese SETJCW NLUSERLANG=221 Return
SETVAR TERM “HPTERM-ASIAN” Return
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Customizing HP Easytime/XL

The system manager can use the setup program to customize the
HP Easytime/XL program. See “Customizing HP Easytime/XL” in this
manual. This program is optional. HP Easytime/XL arrives set up, it
can be used as is, or customize it to meet your particular needs.

Enabling HP Easytime/XL

Before using HP Easytime/XL, the program must be enabled. This is a
system administrator responsibility. If you are not the system
administrator, ask the system administrator to do this for you.

1. Log on to the system as MANAGER.SYS.

2. From the system prompt, type:

:RUN EASYTIME.PUB.SYS Return

3. Press F5 OK to enable HP Easytime/XL.

Start HP Easytime/XL and begin performing tasks.

Disabling HP Easytime/XL

1. Log on to the system as MANAGER.SYS.

2. Start HP Easytime/XL.

3. Switch to system administrator mode.

4. From the Main menu, press D for Disable HP Easytime/XL .

A dialog box prompts you for confirmation.

5. Press F5 OK to confirm disabling HP Easytime/XL.

6. Press F5 Yes to confirm again.
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2 Getting Started
This chapter describes how to log on to the system and start
HP Easytime/XL, and how to exit and log off. It also explains the basic
skills needed to use the product effectively, including the following:

• Logging on and starting HP Easytime/XL

• Exiting and logging off

• Getting help

• Using the Main menu

• Screens

• Menus

• List boxes

• Dialog boxes

• Understanding operating modes

• Basic skills
19
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Logging On
Logging on means identifying yourself to the computer. You must
identify yourself as an authorized user by typing your logon identity
(username and account) and a password (if any). If you do not have a
logon identity, ask your system administrator to give you one.

Once you log on, you begin communication with the HP e3000 computer
and can start working.

Log On

1. After switching on the terminal, press Return one or more times until
you see the system prompt.

2. Type your logon identity. For example:

MPE/iX :HELLO PAT.FINANCE

3. Press Return .

4. Type any required passwords.

As a security precaution, passwords are not displayed on the screen
as you type them.

5. Press Return

A system prompt (:) signals the start of your session. A welcome
message may also be displayed.

Starting HP Easytime/XL

Once you have logged on (and the program is enabled) you can start
HP Easytime/XL.

1. From the system prompt, type:

:RUN EASYTIME.PUB.SYS Return

Unless your system administrator has changed this, the Main menu
is displayed on your screen. This is where you begin your work.
Figure 2-1 illustrates the Main menu.
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Logging On
Figure 2-1 Main Menu

Welcome to HP Easytime/XL. Now you are ready to learn about basic
skills and HP Easytime/XL tasks.

The following are the basic skills needed to use HP Easytime/XL. If you
do not want to continue with basic skills now, you can exit
HP Easytime/XL with the following procedure.

Exiting HP Easytime/XL

1. Press F3 E to open the Exit menu.

2. Press X for Exit HP Easytime/XL .

3. Press F5 Yes to confirm that you want to exit.

This ends your current HP Easytime/XL session.

MPE/iX Operating System

You can also exit HP Easytime/XL temporarily to execute an MPE/iX
command or start another application, and then quickly return to
HP Easytime/XL.

1. Press F8 Close  one or more times until the Main menu appears.

2. Press G or Go to MPE.

The MPE/iX system prompt is displayed on the screen. You can now
enter an MPE/iX command or start another application.

Field
Help

Fast
Select

Select To/From
Menu Bar

Exit
Easytime

HP Easytime/XL Main

Exit Help

[ ]
[ File Management... ]
[ Job Management... ]
[ Session Management... ]
[ Console Management... ]
[ Backup Management... ]
[ Printer Management... ]
[ Go To MPE... ]

[ Switch to System Administrator... ]
[ Change Administrator Password...  ]
[ Disable HP Easytime/XL... ]

Print File Management...
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3. Type EXIT  when you want to return to HP Easytime/XL.

If you do not need to return to HP Easytime/XL, you can type BYEto
end the MPE/iX session and log off. When you end the MPE/iX
session, you end the HP Easytime/XL session as well.

Log Off

1. Exit HP Easytime/XL.

2. From the system prompt, type: BYE.

A closing message displays the current time, date, and amount of
CPU time your session used. Switch off the terminal screen after you
receive the disconnect message.
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Getting Help
There are two ways to get help in HP Easytime/XL. Access the Help
menu for a complete index of help topics, or press F1 Field Help  for
context sensitive help about an object on the screen.

The HP Easytime/XL Help menu is available on every screen. The
Help menu provides the following six categories of help information:

Use this topic To do access this:

Help HP Easytime/XL help facility.

Basic Skills Information about basic skills and
concepts needed to use the product
effectively.

Procedures Step-by-step procedures for every task
available on a screen.

Keys Cursor movement keys; dialog box key,
function keys, and editing keys in
HP Easytime/XL.

Glossary Alphabetical listing of HP Easytime/XL
terms and definitions.

Version Information about the current version
of HP Easytime/XL on your system.

Using the Help Menu

1. Press F4 H to open the Help menu.

2. Press the key that corresponds to the underlined character in the
menu item you want. For example, press P for help on Procedures .

Figure 2-2 shows an index of help topics for this screen.
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Figure 2-2 Index of Help Procedures

Selecting a Help Topic

1. Press ▲ or ▼ key to move the cursor to a help topic.

2. Press either F3, Spacebar , or Return  to select the topic.

3. Press F5 Read.

A help window displays help information about that topic.

4. Press F8 Close  when you are finished reading.

If you want to choose another help topic, press Tab twice to go back to
the list of topics and select another.

5. Press F8 Close  again to close the Help menu.

Help Key

With the help key you can access field specific help about an object on
the screen or in a menu, for example, a task or data entry field.

1. Move the cursor to an object on the screen.

2. Press F1 Field Help  to get help information about that object.

3. Press F8 Close  to close the help window when you are finished
reading.
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Select a topic and choose Read.

Adding file security
Checking the status of files
Copying files from disk to tape (restoring)
Copying files from tape to disk (storing)
Copying multiple files
Copying one file
Deleting files
Displaying a set of files
Moving multiple files
Moving one file
Printing files
Reading the contents of a file
Removing file security
Renaming a file

Procedures Index

[ Read ] [ Close ]

Deleting files
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Main Menu
The Main menu is the focal point in HP Easytime/XL and usually the
first thing seen after starting HP Easytime/XL. Any HP Easytime/XL
screen can be accessed through the Main menu.

Opening a Screen from the Main Menu

1. Press the key that corresponds to the underlined letter in the screen
you want to open, for example, press P for Print File
Management . Or, use the ▲ or ▼ keys to highlight the screen you
want, and press Return . The topics are shown in Figure 2-3.

Figure 2-3 Selecting Screen

Main Menu Items

1. Press ▲ or ▼ keys to highlight a menu item.

2. Press F1 Field Help  to get context sensitive help about the screen
or task.
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Help

Fast
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Select To/From
Menu Bar

Exit
Easytime

HP Easytime/XL Main

Exit Help

[ ]
[ File Management... ]
[ Job Management... ]
[ Session Management... ]
[ Console Management... ]
[ Backup Management... ]
[ Printer Management... ]
[ Go To MPE... ]

[ Switch to System Administrator... ]
[ Change Administrator Password...  ]
[ Disable HP Easytime/XL... ]

Print File Management...
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Screens
Each area of management in HP Easytime/XL (for example, File or
Session Management) is displayed on a screen. Access information
about the current status of the system and perform system
management tasks through the screens.

Figure 2-4 illustrates the parts of a File Management screen.

Figure 2-4 Parts of a Screen
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Screen Parts

Each HP Easytime/XL screen contains the following:

Title bar A horizontal bar that is located at the
top of each screen and contains the
name of the screen.

Menu bar A horizontal bar located directly below
the title bar containing the name of the
HP Easytime/XL menus.

Status bar The third line of the screen (directly
below the menu bar). The status line
displays messages from the system that
tell you when you need to do
something, for example, load a form in
the printer. The status line also
displays the time the screen was last
updated.

List box A box listing available choices, for
example, a list of available files on the
system.

Message line The bottom line on the screen.
Information about what is happening
on the system is displayed here.

Function keys Along the top of the keyboard are eight
keys labeled F1 through F8. These
function keys correspond to the eight
function key labels along the bottom of
each HP Easytime/XL screen.
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All HP Easytime/XL menus appear on the menu bar. The menu bar
appears directly below the title bar. Each menu contains a list of
available tasks (menu items) that let you determine what action to take
next. You can also access the Main menu from the menu bar on any
HP Easytime/XL screen.

Figure 2-5 illustrates the menus on the File Management screen.

Figure 2-5 File Management Screen

Opening a Menu

Open any menu in HP Easytime/XL by going to the menu bar and
pressing the key that corresponds to the underlined letter in the menu
you want to open. For example, to open the Actions menu:

1. Press F4 to go to the menu bar.

2. Press A to open the Actions menu.

Use F2 Fast Select and an underlined character for a faster method of
opening menus. For example, press F2 A to open the Actions menu, and
a list of tasks opens, as shown in Figure 2-6.
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Figure 2-6 Actions Menu on File Management Screen

Choosing a Menu Item

All HP Easytime/XL tasks are listed on menus. Perform tasks by
choosing the menu item.

1. Press the key that corresponds to the underlined character in the
menu item you want. For example, press D for Delete . Or, use ▲ or
▼ keys to highlight the menu item you want, and press Return .

Closing Menu

1. Press F4 again to close a menu and exit the menu bar. Or, press right
arrow key or left arrow key to open other menus on the menu bar.

The menu closes automatically when you open another.
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Understanding Menu Conventions

Not all HP Easytime/XL menu items look the same. Menu items can be
shaded, preceded by an asterisk, highlighted, or followed by an ellipsis
(...). Additionally each menu item has one letter underlined. The
following list explains HP Easytime/XL menu conventions.

Menu Convention Definition

Shaded This menu item or screen is not
available. This can be because you are
currently working on this screen, or
because system administrator access is
required to perform the task.

Ellipsis (...) Indicates that a dialog box or another
screen will appear when you select this
item.

Asterisk Indicates which default setting is
active.

Underlined Character Indicates which key to press to access a
menu or to select a menu item.
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List Boxes
Each HP Easytime/XL screen contains at least one list box. A list box
is an area displaying columns of information. These can be items
related to the current HP Easytime/XL screen, for example, a list of
files on the File Management screen or a list of available choices, for
example, printers currently available on the system.

Identifying a List Box

Every list box contains a scroll bar on the right edge (and/or bottom
edge) of the list box. If there are more items available than fit in the list
box, scroll bars allow you to scroll through the list to view more
information. The scroll bar arrows indicate the directions you can
scroll in a list.

Scrolling in a List Box

The cursor keys used depend on the kind of terminal and keyboard you
have. Use the following keys to scroll in a list box:

To Scroll Press these keys

Up one line ▲ key

Down one line ▼ key

Up one page Shift  + ▲ key or Scroll Up  key

Down one page Shift  + ▼ key or Scroll Down  key

Right one page Next  key

Left one page Prev  key

Top of list Home  key or (arrow pointing upper left)

Bottom of list Shift  + Home  key

Selecting Items

When working in a list box, select one item, multiple items, a range of
items, or all items.

1. Move the cursor to the item you want to select.

2. Press either F3, Return , or Spacebar .

The item selected should be highlighted.

If you selected the wrong item, cancel your selection by pressing F3,
Return , or Spacebar  again.

3. Repeat steps one and two to select as many items as you like.
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Selecting a Range of Items

1. Move the cursor to the first item you want to select.

2. Press F2 Fast Select  and then F3 Select .

3. Move the cursor to the last item you want to select.

As the cursor is moved, the items in the list are highlighted line by
line.

4. Press F2 Fast Select  and then F3 Select  to end the range
selection.

Selecting All Items

1. Press F2 Fast Select and then / key.

All items in the list are selected. This includes items that are not
visible in the list box.

Cancel All Selections

1. Press F2 Fast Select  and then \ key. Or, press F5 Update
Display .

Updating the display always cancels any selected items.
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Dialog Boxes
HP Easytime/XL uses dialog boxes to present information, or to
prompt you for data needed to complete a task. Dialog boxes are
windows that appear on the screen and overlay portion of the current
display.

Dialog boxes usually contain one or more fields (areas that can be filled
in or edited), or a list of choices from which a value can be selected.

Whenever an ellipsis (...) appears after a menu item, a dialog box (or
another screen) follows.

When a dialog box appears, input information in any of the following
ways:

• Type the information in a field.

• Select one or more items in a list.

• Choose from a set of available options.

Typing Text in a Field

1. Press Tab key to move from one data entry field to the next.

2. Type the requested information.

Correcting Errors

Use any of the following keys to correct typing errors:

To do this Press these keys

Go to insert mode Insert char  key

Exit insert mode Insert char  key again

Delete a character Delete char  key

Delete one character to the
left of cursor Backspace  key

Delete all characters Delete line  key

Delete all characters to the
right of the cursor Clear line  key

Selecting Items

Only one item can be selected from a list that appears within a dialog
box. Often, one item is highlighted (preselected).
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1. Use the ▲ and ▼ keys to move the cursor to the item you want to
select.

2. Press either F3, Return , or Spacebar  keys.

Selecting Options

1. Press Tab key to move to the option wanted.

2. Press either F3, Return , or Spacebar  key to choose the option.

Selected choices are marked by either an asterisk <*> , or by [X} ,
refer to Figure 2-7.

Figure 2-7 Selected Options

Moving in a Dialog Box

Use the following keys to move in a dialog box:

To move Press these keys

To the next field Tab key

To the previous field Shift + Tab  keys

One character to the right Right arrow  key

One character to the left Left arrow  key

Canceling Dialog Box

• Press F8 Cancel  to cancel a task and close the dialog box.

Closing Dialog Box

• Press F5 OK to complete a task and close the dialog box.

[X] Do not overwrite files on disk.
[ ] Create accounts, groups, users as needed.
[X] Restore files to logon group and account.
[ ] Restore directory information.

<*> Full
< > Partial

Type

Restore options

Selected
options
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Operating Modes
There are two operating modes in HP Easytime/XL:

• User mode

• System administrator mode

When HP Easytime/XL is started, it is automatically in user mode. In
this mode, some tasks are not available (shaded). Usually, shaded tasks
require system administrator access.

System Administrator Password

A password is required when changing to system administrator mode.
If you are the system administrator you set the system administrator
password the first time you change to system administrator mode.

1. Log on as MANAGER.SYS.

2. Start HP Easytime/XL.

3. From the Main menu, press A for Switch to System
Administrator.

4. Type the system administrator password, and press Return  key.

The password must begin with a letter and can contain 8
alphanumeric characters. For security reasons, each character typed
is displayed as an asterisk (*).

5. Type the password again for verification.

6. Press F5 OK to set the system administrator password.

System Administrator Mode

You must be in system administrator mode to perform every
HP Easytime/XL task, and to manage all files, job, and sessions on the
system.

1. From the Main menu, press A for Switch to System
Administrator .

2. Type the system administrator password.

The password must begin with a letter and can be 8 alphanumeric
characters. For security reasons, each character typed is displayed
as an asterisk (*).

3. Press F5 OK to change to system administrator mode.
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Changing System Administrator Password

For security reasons, it is a good idea to change the system
administrator password on a regular basis. Be sure not to use a word
that is easy to identify, such as your own name. This is a system
administrator task.

1. Change to system administrator mode.

2. From the Main menu, press W for Change Administrator
Password.

3. Type the new password, and press Return  key.

The password must begin with a letter and can contain 8
alphanumeric characters. For security reasons, each character typed
is displayed as an asterisk (*).

4. Type the password again for verification.

5. Press F5 OK to set the system administrator password.

User Mode

If you are in user mode, you can only manage your own files, jobs, and
sessions.

• From the Main menu, press U key for Switch to User .

No passwords are required when changing to user mode.
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Basic Skills
This section guides you through a few tasks so that you can practice
using some of the basic skills just introduced. A file called ETLEARNhas
been created for use throughout these exercises. Do the tasks in the
order they are presented, as later tasks build on previous ones.

Practice Basic Skills

The file ETLEARNis located in the public group of the system account,
PUB.SYS. Programs and applications available to all users of the system
reside there. Before working with the ETLEARNfile, make a copy for your
own group.

If you are not already at the system prompt (:):

1. Press F8 Close  one or more times until the Main menu screen is
displayed.

2. Press G for Go to MPE .

3. At the system prompt, type:

:COPY ETLEARN.PUB.SYS Return

This command copies the file ETLEARN to your logon group and
account.

4. From the system prompt, type:

:EXIT Return

This command takes you back to HP Easytime/XL.

Reading a File

You can read the contents of any file if you created it, or if you have read
access as provided through MPE/iX security. With this task you can
read the contents of ETLEARN.

1. From the Main menu, press F for File Management .

2. Select the file ETLEARN.

3. Press F2 A to open the Actions menu.

4. Press R for Read.

The first 15 lines of the file are displayed on your screen. Use the
scroll keys to browse through the contents of the file.

5. Press Shift + down arrow  key to scroll to the next page.

6. When finished reading, press F8 Close to close the file and go back to
the File Management screen.
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Printing

When requesting a file to be printed, create a print file. A print file is a
copy of the file that the system creates and sends to the printer. The
files are printed from the File Management screen.

1. Select the file ETLEARN from the File Management screen.

2. Press F2 A to open the Actions menu.

3. Press P fro Print .

4. Type 3 in the No. of copies  field.

5. Press F5 OK.

This requests three copies of the file ETLEARN to be printed.

Copying a File

Files can be copied from the same group or another group in your logon
account. With this task, you are going to make a copy of the file
ETLEARN and keep it in your logon group.

1. Select the file ETLEARN from the File Management screen.

2. Press F2 A to open the Actions menu.

3. Press C for Copy.

A dialog box prompts you to type a file name and group.

4. Type a new name for the file ETLEARN.

A file name can be a maximum of eight alphanumeric characters and
must begin with a letter.

Keep the file in your logon group, so leave the group field as it is.

5. Press F5 OK to copy the file.

Deleting a File

You can delete your own files from the system. It is important to
remember that when you delete a file, you cannot get it back.

1. Select the file ETLEARN from the File Management screen.

2. Press F2 A to open the Actions menu.

3. Press D for Delete .

Whenever you delete a file, HP Easytime/XL prompts you to confirm
the action.

4. Press F5 Yes to confirm that you want to delete this file.
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3 HP Easytime/XL Tasks
This chapter describes the tasks that can be performed with
HP Easytime/XL. HP Easytime/XL helps manage the system by
organizing the daily tasks around menus that are easy to identify and
use. These tasks are separated into the following categories:

• Managing Sessions

• Files

• Print Files

• Printers

• Jobs

• Backups

• Console Messages

• Customizing HP Easytime/XL

• Solving Problems
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Managing Sessions
When you log on to the MPE/iX system, you begin a session. This means
communicating with the computer. A session begins when you log on
(HELLO) and ends when you log off (BYE).

The menus at the top the Session Management screen contain all of the
tasks necessary for managing your sessions, including the following:

• Deleting sessions

• Sending messages to other users

• Limiting the number of sessions on the system

• Displaying a set of sessions

• Sorting a list of sessions

Session Management

1. Move the cursor to Session Management  on the Main menu.

2. Press either F3, Return  key, or Spacebar .

The Session Management screen provides information about all the
sessions that are logged on to the computer, including:

• Session name

• User name and account of the session

• Name of the program that the session is running (if there is one).

• Date and time when session was started

• Which session is your session

Refer to Figure 3-1 which shows a Session Management screen.
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Figure 3-1 Session Management

Delete (Abort) a Session

Before performing a routine maintenance on the system, for example, a
backup, you may want to delete any active sessions (log other users off
the system). This ensures that any files currently locked by an
application are available for backup.

1. Select one or more sessions from the Session Management screen.

2. Press F2 A to open the Actions menu.

3. Press D for Delete .

A dialog box prompts you to confirm deletion.

4. Press F5 YES to delete sessions.

CAUTION If a user is working in an application, this task aborts the program and
data may be lost. For that reason, be sure to send a warning message
prompting users to log off before you delete sessions. Refer to “Sending
Messages to Users”.
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Session User Account Program Start Date/Time
Name

ADMIN DAVID FINANCE EASYTIME 04/24/01 3:07 PM
ROSS ROSS PAYROLL EASYTIME 04/24/01 4:10 PM (YOUR SESSION)
PAT PAT PAYROLL HPEDIT 04/25/01 8:22 AM
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Sending Messages to Users

You can send messages to one or more users on the system. For
example, you can send a message asking users to log off before you shut
down the system.

1. Select one or more sessions from the Session Management screen.

2. Press F2 A to open the Actions menu.

3. Press S for Send Message .

4. Enter the message to be sent to other users.

The message can be up to 80 characters in length. The field shifts to
the left as it is typed providing more space.

If you want a user to reply to the message, be sure to include the
session name so that the user knows which session to answer. The
session name and user are not automatically displayed with the
message.

5. Press F5 OK to send the message.

Limiting the Number of Sessions

If you are the system administrator, you can limit the number of users
allowed to log on to the system at one time.

1. Press F2 A to open the Actions menu.

2. Press L for Limit No. of Sessions .

A dialog box prompts you to enter the session limit.

3. Enter the number of sessions allowed to run concurrently.

4. Press F5 OK to set the session limit.

Displaying Sessions

When you log on to HP Easytime/XL and go to Session Management,
you see all the sessions currently logged on to the system. You can use
the View menu to restrict your view to a particular set of sessions, for
example, those in a specific account.

1. Press F2 V to open the View menu.

2. Press V for Set View .

A dialog box prompts you to enter a set of sessions.

3. Enter the set of sessions you would like to view.

Wildcard characters can be used to define a set.

4. Press F5 OK to display the new view.
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Only those sessions specified are now displayed on the screen. This
new view will last until you exit HP Easytime/XL, or change the
view again.

Resetting View

If view has been set to show only selected sessions, it can be reset to
display all sessions on the system.

1. Press F2 V to open the View menu.

2. Press R for Reset View .

Sorting Sessions

Define how sessions are sorted (order in which they are displayed) on
the Session Management screen. Sessions are sorted alphabetically by
session name, this can be changed to sort by user or account:

1. Press F2 V to open the View menu.

2. Choose one of the following settings:

• Sort by Session Name

• Sort by User

• Sort by Account

The sessions on the screen will be sorted according to the selected
setting. An asterisk (*) appears in front of the selected setting and the
setting remains valid until exiting HP Easytime/XL, or until the sort
setting is changed.
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Files
Files store the information with which you work. Reports, spreadsheets,
letters, and application programs are all files. If you use the MPE/iX
editor to create a document, this document is a file.

You can use the File Management screen to manage the files on your
system. If you cannot perform a task with a particular file, it may be
secured. Ask the creator of the file to release it, or see your system
administrator for assistance.

The menus at the top of the File Management screen contain all of the
tasks necessary for managing the files including the following:

• Printing

• Copying

• Deleting

• Renaming

• Moving

• Reading

• Releasing and Securing

• Displaying a set of files

• Sorting

Accessing File Management

1. Move the cursor to File Management  on the Main menu.

2. Press either F3, Return  key, or Spacebar .

The File Management screen provides the following information about
files on the system:

• File Name

• Group

• Account

• File Code (ASCII or application type)

• Status (Secured or Released)

• Size (in kilobytes)

Figure 3-2 illustrates the File Management screen.
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Figure 3-2 File Management

Printing a File

When you request a file to be printed, a copy of the file (print file) is
created and sent to the printer.

1. Select one or more files from the File Management screen.

2. Press F2 A to open the Actions menu.

3. Press P for Print .

A dialog box prompts you for the number of copies.

4. Enter the number of copies you want printed.

5. Press F5 OK to print the file.

If any files have lockwords, a dialog box prompts you to enter them.

The print file is directed to the HP Easytime/XL printer. The printer
can be changed with the task Set Printer  on the Options menu.

Copying Files

Files can be copied to the same group, or to another group in your logon
account. Files can also be copied to and from tape for security purposes.
If you want to copy a secured file, ask the creator of the file to release it.

Field
Help

Fast
Select

Select To/From
Menu Bar

Update
Display

Close

HP Easytime/XL File Management

Actions Main View Options Exit Help
Display last updated at 9:36 AM

File Name Group Account Code Status Size(KByte)

BUDGET PUB PAYROLL WDOC SECURED 24
LETTER PUB PAYROLL ASCII SECURED 7
OFFERS PUB PAYROLL ASCII SECURED 26
Chapter 3 45



HP Easytime/XL Tasks
Files
Copying One File

1. Select one file from the File Management screen.

2. Press F2 A to open the Actions menu.

3. Press C for Copy.

A dialog box prompts you for a file name and group.

4. Enter a file name, enter a new name if copying the file to the same
group.

5. Enter a group if you want to copy the file to a group other than your
logon group.

6. Press F5 OK to copy the file.

If the file has a lockword, a dialog box prompts you to enter it.

Copying Multiple Files

You cannot rename files when copying more than one at the same time.

1. Select files to copy.

2. Press F2 A to open the Actions menu.

3. Press C for Copy.

A dialog box prompts you for a group.

4. Enter a group if you want to copy the files to a group other than your
logon group.

5. Press F5 OK to copy the files.

If any files have lockwords, a dialog box prompts you to enter them.

Storing Files

In addition to making regular backups, you can copy files to storage
media at any time for security purposes.

1. Prepare storage media and device.

See the reference information that you received with your drive.

2. Load the drive.

CAUTION When starting the store process, any files currently stored on this
storage media will be lost.

3. Select one or more files from the File Management screen.

4. Press F2 A to open the Actions menu.

5. Press S for Store .
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A dialog box may prompt you for more information.

Supply any requested information and press F5 OK to continue.

During the store process, HP Easytime/XL displays a monitoring
screen where you can check the progress of the task. Do this by
pressing F5 Update Display  periodically. During the store process,
you cannot use this terminal for anything else.

If the store is progressing correctly, the monitoring screen displays
the percent complete, for example:

STORE OPERATION IS 25% COMPLETE.

When the store is finished, the following message is displayed:

Store finished successfully. See report ETSTLST.

6. Press F8 Close  to close the monitoring screen.

Stopping the Store Process

1. Press F7 Stop .

2. Press F5 Yes to confirm.

3. Press F8 Close  to close the monitoring screen and go back to File
Management.

It can take several minutes for the store process to stop.

Verifying Files Stored

HP Easytime/XL creates a print file listing every file stored, and every
file the system was not able to store. Check this report to verify that all
files have been successfully stored on tape.

The name of the report file is ETSTLST. You can view and read the
contents of this file on the Print File Management screen. This file can
be quite large and so the status is ON HOLD. Take the file off hold if you
want to print it.

Setting Store Options

Special store options can be set that apply when storing files. If you are
the system administrator you can save these options permanently.

1. Press F2 O to open the Options menu.

2. Press S for Set Store Options .

A dialog box prompts you to choose store options.

3. Enter a file name, group, and account to save the store report in a
file. If the file does not exist, HP Easytime/XL creates it for you.

4. Choose one of the available options.
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See “HP Easytime/XL Options” if you need more information.

5. Press F6 Save to save the store options permanently.

Or, press F5 OK to save the store options for this session only.

Restoring Files

To restore one or more files that have been stored:

1. Prepare storage media and device.

Refer to the reference information that was received with the drive.

2. Load the drive.

3. Press F2 A to open the Actions menu.

4. Press T for Restore .

A dialog box prompts you for the names of the files you want to
restore.

5. Enter one file name, group, and account.

Or, specify a set of files using wildcard characters.

6. Press F6 Add to List .

If a file was added to the list by mistake, select it and press F7
Delete from List .

Steps 5 and 6 can be repeated to add as many files to the list as
necessary.

7. When the files to be restored list is completed, press F5 OK to
continue.

A dialog box may prompt you for more information.

Supply any requested information and press F5 OK to continue.

During the restore process, HP Easytime/XL displays a monitoring
screen where you can check the progress of the task. Do this by
pressing F5 Update Display  periodically. During the restore
process, the terminal cannot be used for anything else.

When the restore is finished, the following message is displayed:

Restore finished successfully. See report ETRSTLST.

8. Press F8 Close  to close the monitoring screen.

Stopping Restore Process

1. Press F7 Stop .

2. Press F5 Yes to confirm.
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3. Press F8 Close  to close the monitoring screen and go back to File
Management.

It can take several minutes for the restore process to stop.

Verify Files Restored

HP Easytime/XL creates a print file listing every file restored, and
every file the system was not able to restore. Check this report to verify
that all files have been successfully restored.

The name of the report file is ETRSTLST. You can view and read the
contents of this file on the Print File Management screen. This file can
be quite large and so the status is ON HOLD. The file must be taken off
hold to be printed.

Setting Restore Options

Special options can be set for restoring files. If you are the system
administrator, you can save these options permanently.

1. Press F2 O to open the Options menu.

2. Press R for Set Restore Options .

A dialog box prompts you to choose restore options.

3. Enter a file name, group, and account to save the restore report in a
file. If the file does not exist, HP Easytime/XL creates it for you.

4. You can choose one or more of the available options.

See “HP Easytime/XL Options” if more information is needed.

5. Press F6 Save to save the restore options permanently.

Or, press F5 OK to save the restore options for this session only.

Deleting Files

This task can be used to delete unwanted files from the system.

1. Select one or more files from the File Management screen.

2. Press F2 A to open the Actions menu.

3. Press D for Delete .

4. Press F5 Yes to confirm deletion of files.

If the file has a lockword, a dialog box prompts you to enter it.

CAUTION It is important to remember that when you delete a file, you cannot get
it back.
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Renaming Files

You can rename any file that you created and that is in your logon
account.

1. Select one file from the File Management screen.

2. Press F2 A to open the Actions menu.

3. Press M for Move/Rename.

A dialog box prompts you for a file name and group. Your logon group
is displayed.

4. Enter a new file name.

5. Enter a group name if you want the renamed file moved to a group
other than your logon group.

6. Press F5 OK to rename the file.

If the file has a lockword, a dialog box prompts you to enter it.

Moving Files

Files can be moved to and from other groups, but not to and from other
accounts. You can only move files that you created and that are in your
logon account.

Moving a File to Another Group

1. Select one file from the File Management screen.

2. Press F2 A to open the Actions menu.

3. Press M for Move/Rename .

A dialog box prompts you for a file name and group.

4. Enter the file name, or if you want to give the file a new name, enter
a new file name. otherwise, enter the old file name.

5. Enter a group name if you want to move the file to a group other
than your logon group.

6. Press F5 OK to move the file.

If the file has a lockword, a dialog box prompts you to enter it.

Moving Multiple Files

When moving more than one file to another group, you cannot rename
them at the same time.

1. Select files from the File Management screen.

2. Press F2 A to open the Actions menu.
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3. Press M for Move/Rename.

A dialog box prompts you for the new group. Your logon group is
displayed.

4. Enter a group name if you want to move the files to a group other
than your logon group.

5. Press F5 OK to move the file.

If any files have lockwords, a dialog box prompts you to enter them.

Reading File Contents

You can read the contents of any file that you created. You may also be
able to read the contents of a secured file if you have read access as
provided by MPE/iX security provisions.

1. Select one or more files from the File Management screen.

2. Press F2 A to open the Actions menu.

3. Press R for Read.

If the file has a lockword, a dialog box prompts you to enter it.

The first 15 lines of the file are displayed. Use the scroll keys to
browse through the contents of the file.

If you have selected several files to read, press F5 Read Next  to
display the contents of the next selected file.

If the next selected file has a lockword, a dialog box prompts you to
enter it.

4. Press F8 Close  to close the file when finished reading.

Removing MPE/iX Security Provisions

You can remove MPE/iX security provisions from any file that you
created. This means that users in any account can read, copy, delete, or
print the file.

1. Select one or more files from the File Management screen.

2. Press F2 A to open the Actions menu.

3. Press L for Release .

If any files have lockwords, a dialog box prompts you to enter them.
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Adding MPE/iX Security

If you previously removed MPE/iX security from a file, you can
reestablish security provisions with this task. You can only secure a file
if you created it.

1. Select one or more files from the File Management screen.

2. Press F2 A to open the Actions menu.

3. Press E for Secure .

If any files have lockwords, a dialog box prompts you to enter them.

Displaying Files

When you log on to HP Easytime/XL and go to File Management, you
see all the files in your logon group and account. You can expand the
view to include files in another group, or restrict it to a smaller set of
files for easier management.

1. Press F2 V to open the View menu.

2. Press V for Set View .

A dialog box prompts you to enter a set of files. It displays all files in
the group PUB, in the account SYS.

3. Enter the set of files you would like to view. Wildcard characters can
be used to define a set of files.

4. Press F5 OK to display the new view.

Only those files that you specified are displayed on the screen. This
new view will last until you exit HP Easytime/XL, or change the
view again.

Resetting View

If you have set a view of files, you can reset it to all the files in your
logon group and account.

1. Press F2 V to open the View menu.

2. Press R for Reset View .
52 Chapter 3



HP Easytime/XL Tasks
Files
Sorting Files

You can define how files are sorted (order in which they are displayed)
on the File Management screen. Start HP Easytime/XL and go to the
File Management screen, files are first sorted alphabetically by
account, and then by group and file name. To change this:

1. Press F2 V to open the View menu.

2. Choose one of the following settings:

• Sort by File Name

• Sort by Group

• Sort by Account

The files on the screen will be sorted according to the settings selected.
An asterisk (*) appears in front of the selected setting. This setting is
valid until you exit HP Easytime/XL, or until it is changed again.
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Print Files
Print files are files users have requested for printing, but have not yet
printed. Because the printer can only process one file at a time, print
files need to be organized in a logical order (queued) when sent to the
printer. HP Easytime/XL sorts print files according to their status and
prints each in turn.

The menus at the top of the Print File Management screen contain all
of the tasks necessary for managing the print files, including:

• Status

• Deleting

• Put on hold

• Take off hold

• Moving a print file to the top of the queue

• Reading the contents of a print file

• Changing the number of copies

• Changing printers

• Reprinting a print file

• Loading and aligning forms

• Displaying a set of print files

• Sorting

The Print File Management screen provides information about all
pending print files on the system, Including:

• Print File Name

• User who created the print file

• Account

• Printer (which printer that file will be assigned)

• Status of print file

• Number of copies requested

• Approximate length (in pages) of the print file

• Name of the required form (if available)

Figure 3-3 illustrates the Print File Management screen.
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Figure 3-3 Print File Management

Accessing Print File Management

1. Move cursor to Print File Management  on the Main menu.

2. Press either F3, Return  key, or Spacebar .

Monitoring Status

Monitor printing on your system by checking the status field on the
Print File Management screen.

The status of a print file can be one of the following:

Status Means

CREATE A print file is being created.

PRINTING Print file is printing now.

READY Print file is ready (waiting) to print.

ON HOLD Print file has been put on hold. This means that the
print file cannot print until you take it off hold.

LOAD FORM The print file requires a special form (kind of paper).
Because this print file is at the top of the print queue,
all printing on this printer has stopped. You must load
the form before printing can continue.

ALIGN FORM The print file requires that you align the form before
printing. Because this print file is at the top of the print

Field
Help

Fast
Select

Select To/From
Menu Bar

Update
Display

T Close

HP Easytime/XL Print File Management

Actions Main View Options Exit Help
Display last updated at 9:58 AM

Print User Account Printer Status No. of Length Forms
File Name Copies  (pages)

REPORT MGR SYS LP PRINTING 1 ~ 1
CHECKS DAVID FINANCE LP READY 2 ~ 4
BUSPLN GORDON MKT LP READY 1 ~12
BUDGET CAROL PAYROLL LP READY 1 ~ 4
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queue, all printing on this printer has stopped. You
must align the form before printing can continue.

PROBLEM There is a problem with the printer. Check to make
sure the printer is switched on, or check for a paper
jam.

UNKNOWN This status indicates a problem with the printing
program. Contact your system administrator for
assistance.

Deleting a Print File

If you no longer want a print file to print, you can delete it from the
print queue.

1. Select one or more print files from the Print File Management
screen.

2. Press F2 A to open the Actions menu.

3. Press D for Delete .

4. Press F5 Yes to confirm deletion of the print file.

Put On Hold

A print file can be put on hold to keep it from printing until you are
ready.

1. Select one or more print files from the Print File Management
screen.

2. Press F2 A to open the Actions menu.

3. Press H for Put on Hold .

The status of the print file changes to ON HOLD.

Take Off Hold

Once the print file is put on hold, it will not print until it is taken off
hold.

1. Select one or more print files with the status ON HOLD.

2. Press F2 A to open the Actions menu.

3. Press O for Take off Hold .

The status of the print file changes to READY.

Rearranging Print Files

If one or more print files printed need the priority changed, you can
move them to the top of the print queue. These files are then the next to
be printed.
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1. Select one or more print files from the Print File Management
screen.

2. Press F2 A to open the Actions menu.

3. Press N for Print Next .

Reading Contents of Print File

You can read the contents of a print file while it is waiting in the print
queue.

1. Select one or more print files from the Print File Management
screen.

2. Press F2 A to open the Actions menu.

3. Press R for Read.

If the first print file has a lockword, enter it.

The first 15 lines or the print file are displayed. Use the scroll keys to
browse through the contents of the print file.

If you have selected several print files to read, press F5 Read Next to
display the contents of the next selected print file.

If the next selected print file has a lockword, enter it.

4. Press F8 Close  to close the print file when you are finished reading.

Changing the Number of Copies

You can increase or decrease the requested number of copies for a print
file with this task.

1. Select one or more print files from the Print File Management
screen.

2. Press F2 A to open the Actions menu.

3. Press C for Change No. of Copies .

A dialog box prompts you for the number of copies.

4. Enter the number of copies you want printed.

5. Press F5 OK to change the number of copies.
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Changing Printers

To route your print files to another printer use this task:

1. Select one or more print files from the Print File Management
screen.

2. Press F2 A to open the Actions menu.

3. Press P for Change Printer .

A dialog box displays a list of available printers.

4. Select a printer from the list

5. Press F5 OK to change the printer.

Interrupt (Stop) Printing

You can stop (interrupt) a file that is printing, and start printing again
from the beginning. Use this task to recover after a paper jam.

1. Select the print file that is currently printing.

2. Print F2 A to open the Actions menu.

3. Press E for Reprint .

Loading Forms

Some print files need to be printed on a form or special kind of paper.
When a form is needed, the status line on your screen displays the
message: LOAD FORM. You must respond to the request before printing
on this printer can continue.

1. Select a print file with the status Load Form .

2. Press F2 A to open the Actions menu.

3. Press L for Load Form .

A dialog box displays information about the kind of form required.

4. Load the correct form in the printer.

Or, choose Put on Hold  from the dialog box. In this particular case,
you cannot use the Actions menu to put the form on hold.

5. Press F5 OK when the form is loaded and you want to start printing.

Aligning Form

Some print files that require a form also require that you align the form
before printing. This is to ensure that all alignments are set before
running a large quantity.

When alignment of a form is needed the status line on the screen
displays the message: ALIGN FORM. You must respond to this request
before printing on this printer can continue.
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1. Select a print file with the status Align Form .

2. Press F2 A to open the Actions menu.

3. Press F for Align Form .

A dialog box prompts you to align the form.

4. Align the form in the paper tray.

Or, choose Test  to first print a test line to check alignment.

5. Press F5 OK to inform the system that the form is aligned.

Displaying Print Files

Log on to HP Easytime/XL and go to Print File Management, you will
see all the print files under your logon name and account. You may
want to expand the view to include print files in another account, or
restrict it to a particular set of print files, for example, those on a
specific printer.

1. Press F2 V to open the View menu.

2. Press V for Set View .

A dialog box prompts you to enter a set of print files.

3. Enter the set of print files you would like to view. Wildcard
characters can be used to define a set of print files.

4. Select one or more printers.

5. Press F5 OK to display the new view.

Only those print files you specified are now displayed on the screen.
This new view will last until you exit HP Easytime/XL, or change
the view again.

Resetting View

If you have changed your view of print files, you can quickly reset it to
display all the print files under your logon name and account.

1. Press F2 V to open the View menu.

2. Press R for Reset View .
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Sorting Print Files

Start HP Easytime/XL and go to Print File Management, print files are
sorted on the screen by printer. You can change this sorting to print file
name or by status etc.

1. Press F2 V to open the View menu.

2. Choose one of the following Sort  settings:

• Print File Name

• User

• Account

• Printer

• Status

The print files on the screen will be sorted according to the setting
selected. An asterisk (*) appears in front of the selected setting. This
setting is valid until exiting from HP Easytime/XL, or changing the
sort again.
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Printers
All of the printers configured on the system are listed on the Printer
Management screen. The menus at the top of the Printer Management
screen contain all of the options necessary for managing the printers,
including the following tasks:

• Status of printer

• Enabling a printer

• Disabling a printer

• Setting printer Outfence

Accessing Printer Management

You must be in system administrator mode to perform Printer
Management tasks.

1. Move the cursor to Printer Management  on the Main menu.

2. Press either F3, Return  key, or Spacebar .

The Printer Management screen provides information about all the
print devices on the system, including the following:

• Name of printer

• Status of the printer (enabled or disabled)

• Current Outfence set for the printer

Figure 3-4 illustrates the Printer Management screen.

Figure 3-4 Printer Management
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Printer Status Outfence

LASERJET ENABLED 8
LP ENABLED 12
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Printer Status

Check the status of printers on the system on the Printer Management
screen.

The status of a printer can be any one of the following:

Status Means

ENABLED The system administrator has enabled the printer. It is
available for printing.

DISABLED The system administrator has disabled the printer. If
you route your print files to this printer, they will not
print until the printer is enabled.

UNKNOWN This status indicates a problem with the printer or
printing program. Contact your system administrator
for assistance.

Enable Printer

If you are the system administrator, you can enable a printer. This task
activates a printer and makes it available for printing.

1. Select one or more printers from the Printer Management screen.

2. Select F2 A to open the Actions menu.

3. Press E for Enable .

Disable Printer

If you are the system administrator, you can disable a printer. This task
stops a printer and makes it unavailable for printing.

1. Select one or more printers from the Printer Management screen.

2. Select F2 A to open the Actions menu.

3. Press D for Disable .

Setting Printer Outfence

The system administrator can set the printer outfence. By increasing
the outfence, you can prevent files from printing. The outfence can be
any value from 1 to 14. If the outfence is set at 5, for example, then only
those print files with a priority of 6 or high can printed.

1. Select one or more printers from the Printer Management screen.

2. Press F2 A to open the Actions menu.

3. Press O for Set Outfence .

A dialog box prompts you to enter the new outfence.
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4. Enter the outfence number.

5. Press F5 OK to set the outfence.

Setting HP Easytime/XL Printer

You can specify a printer for all printing initiated in HP Easytime/XL,
for example, print files, listings of system errors, or backup reports.
Unless saved by the system administrator, this setting is valid until you
exit HP Easytime/XL.

1. Press F2 O to open the Options menu.

2. Press P for Set Printer .

A dialog box prompts you to select a printer.

3. Select a printer from the list.

4. If you are the system administrator, you can press F6 Save to save
this setting permanently.

Or, press F5 OK to set the printer for this session only.
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Jobs
Much of the work that is done on the system can be accomplished with
jobs. A job is a file that contains commands that would normally be
entered at the keyboard during an interactive session. When starting a
job, the computer interprets and executes these commands
automatically. No further user input is necessary.

HP Easytime/XL sorts jobs according to status and runs each in turn.
These jobs are listed (queued) on the Job Management screen where
they can be managed and can monitor their progress.

The menus at the top of the Job Management screen contain all of the
options necessary for managing the jobs, including the following tasks:

• Status

• Starting

• Deleting

• Scheduling

• Put on hold

• Take off hold

• Suspending and resuming jobs

• Moving a job to top of queue

• Changing status

• Limiting

• Setting Jobfence

• Displaying

• Sorting

The Job Management screen provides the following information about
jobs on the system:

• Job Name

• User name

• Account under which the job is logged

• Program that the job is running (if there is one)

• Status of the job

• Start Date/Time (when job started or when scheduled to start)

Figure 3-5 illustrates the Job Management screen.
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Figure 3-5 Job Management

Accessing Job Management

1. Move the cursor to Job Management  on the Main menu.

2. Press either F3, Return  key, or Spacebar .

Job Status

The jobs can be monitored on the system by checking the status field on
the Job Management screen.

The status of a job can be any one of the following:

Status Means

ACTIVE Job is running now.

READY The job is ready and waiting to run. The maximum
number of jobs that can run at one time has been
reached. This job will run when one of the active jobs is
finished.

SCHEDULED Job is scheduled to run at a later date and time. The
start date and time is displayed on the Job
Management screen.

ON HOLD Job has been put on hold. A job that is on hold cannot
run until it is taken off hold.

SUSPEND The job has been interrupted (suspended) while it was
running. The task Resume can be used to start it again
(from the place where it was stopped).
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Job Name User Account Program Status Start Date/Time

REPORTS PAT FINANCE CI ACTIVE 04/24/01 10:21 AM
UPDATE KURT MKTG CI ACTIVE 04/24/01 11:18 AM
MONTHEND CHRIS TESTING CI READY 04/25/01 11:40 AM
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Starting a Job

1. Press F2 and A to open the Actions menu.

2. Press S for Start .

A dialog box prompts you for a job file name.

Deleting (Abort) a Job

If a job cannot continue because of an error, you may need to delete the
job and restart. To delete any active job or jobs that are waiting in the
job queue:

1. Select one or more jobs from the Job Management screen.

2. Press F2 A to open the Actions menu.

3. Press D for Delete .

4. Press F5 Yes to confirm deletion of jobs.

Scheduling Jobs

Jobs can be scheduled to run at a later date or time, for example, after
you have gone home for the evening. If you have a job that updates a
database, or other files, you can schedule it to run at night when the
files are not being used.

1. Press F2 A to open the Actions menu.

2. Press S or Start .

3. Enter the name of the job file in the Job File Name  field.

If the job file is in a group or account other than your logon group
and account, enter them.

If the file has a lockword, enter it.

4. Enter start date and time for the job.

5. Press F5 OK to schedule the job.

The job appears in the job queue with a status of SCHED and starts at
the scheduled date and time.

Put On Hold

If a job in the job queue is not yet running, you can put it on hold to
delay its running.

1. Select one or more jobs with the status On Hold .

2. Press F2 A to open the Actions menu.

3. Press H for Put on Hold .
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The job appears in the job queue with the status ON HOLD and will not
start until you take it off hold.

Take Off Hold

If one of more jobs are on hold, they must be taken off hold before they
can run.

1. Select one or more jobs with the status On Hold .

2. Press F2 A to open the Actions menu.

3. Press O for Take off Hold .

The job appears in the job queue with a status of ACTIVE or READY.

Suspend (Interrupt) a Job

This task suspends (interrupts) a job in progress. If system resources
are limited, you can speed up the processing of some jobs by suspending
other, less critical jobs.

1. Select one or more jobs with the status Active .

2. Press F2 A to open the Actions menu

3. Press P for Suspend .

The job stops and its status changes to SUSPEND. The job will not
continue until you resume processing.

Resume a Suspended Job

1. Select one or more jobs with the status Suspend .

2. Press F2 A to open the Actions menu.

3. Press R for Resume.

The job continues to run from the point where it was suspended.

Move Job to Top of Queue

If you are the system administrator, you can move a job to the top of the
queue by changing the job status. It becomes the next job to run.

1. Select one or more jobs from the Job Management screen.

2. Press F2 A to open the Actions menu.

3. Press N for Run Next .

Limiting the Number of Jobs

If you are the system administrator, you can limit the number of jobs
running at one time on the system. If the job limit is set at 5, only the
first 5 jobs can begin processing. Subsequent jobs have a status of
READY and wait in the job queue until one of the active jobs ends.
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1. Press F2 A to open the Actions menu.

2. Press L for Limit No. of Jobs .

A dialog box prompts you to type the job limit.

3. Type the number of jobs allowed to run concurrently.

4. Press F5 OK to set the job limit.

Setting Jobfence

If you are the system administrator, you can restrict which jobs are
allowed to execute.

The jobfence is the minimum priority level a job must exceed in order
to run. The jobfence can be any value from 0 to 14. If the jobfence is set
at 8, for example, then only those jobs with a priority of 9 or higher can
run.

1. Press F2 A to open the Actions menu.

2. Press F for Set Jobfence .

A dialog box prompts you to type the jobfence number.

3. Type the jobfence

4. Press F5 OK to set the jobfence.

Displaying Jobs

Log on to HP Easytime/XL and go to Job Management, to view jobs
currently logged on to the system. The view can be restricted to a
particular set of jobs, for example, those in a specific account.

1. Press F2 V to open the View menu.

2. Press V for Set View .

A dialog box prompts you to type a set of jobs.

3. Type the set of jobs you would like to view. Use wildcard characters
to define a set of jobs.

4. Press F5 OK to display the new view.

Only those jobs specified are now displayed on the screen. This new
view will last until exiting HP Easytime/XL, or until the view is
changed again.

Resetting View

If the view of jobs has been changed, it can be reset to display all the
jobs on the system.

1. Press F2 V to open the View menu.

2. Press R for Reset View .
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Sorting Jobs

Start HP Easytime/XL and go to Job Management, jobs are sorted on
the screen by status (the order in which they will run). To change the
sort:

1. Press F2 V to open the View menu.

2. Chose one of the following Sort by  settings:

• Job Name

• User

• Account

• Status

The jobs on the screen will be sorted according to the setting selected.
An asterisk (*) appears in front of the selected setting. This setting is
valid until exiting from HP Easytime/XL or the sort is changed again.
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Backups
Choosing a good backup plan, and scheduling regular backups, are
important to the efficient operation of the system. Regularly scheduled
backups reduce the time needed to perform backups and guarantee the
most recent information is always available to users.

If you are responsible for managing backups on the system, your
responsibilities include the following:

• Designing a backup schedule

• Scheduling and performing regular backups

• Storing and maintaining backup media.

Backup Management

The Backup Management screen displays the current backup schedule
and provides a history of recent backups on the system including:

• Type of backup (full or partial)

• Date the backup was performed

• Number of tapes required for the backup

• Device on which the backup was performed

• Time needed to complete the backup

To access Backup Management:

1. Move the cursor to Backup Management  on the Main menu.

2. Press either F3, Return  key, or the Spacebar .

The Backup Management screen in shown in Figure 3-6.
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Figure 3-6 Backup Management

Designing a Backup Schedule

There are two kinds of backups that can be performed with
HP Easytime/XL:

• Full backups

• Partial backups

A full backup copies all user files on the system whether or not the
information has changed since the last full backup. A partial backup
copies only those files that have changed since the last full backup. Your
backup schedule should include both. A typical backup schedule allows
for one full backup one day a week, and a partial backup on each
remaining work day.

If such a schedule is used, no more than 24 hours worth of information
would be lost if the system should fail.

Refer to Figure 3-6 for a Backup Management screen.

Scheduling Backups

With HP Easytime/XL, you can set up the backup schedule and then
use the Backup Management screen to review backup information.

1. From the Backup Management screen, select one or more days of the
week.

Field
Help

Fast
Select

Select To/From
Menu Bar

Update
Display

Close

HP Easytime/XL Backup Management

Actions Main View Options Exit Help
Display last updated at 10:05 AM

Latest Backups:
Type Date No. of Tapes Device Time needed Files stored

PARTIAL 04/08/01 1 TAPE 7:02 78
PARTIAL 04/09/01 1 TAPE 13:16 159
PARTIAL 04/10/01 2 TAPE 24:10 976
PARTIAL 04/11/01 2 TAPE 30:26 1271
FULL 04/12/01 5 TAPE 1:22:17 6782

MONDAY 9:00 PM PARTIAL LP MON.BCK.SYS
TUESDAY 9:00 PM PARTIAL LP TUE.BCK.SYS
WEDNESDAY 9:00 PM PARTIAL LP WED.BCK.SYS
THURSDAY 9:00 PM PARTIAL LP THU.BCK.SYS
FRIDAY 9:00 PM FULL LP FRI.BCK.SYS

Scheduled Backups:
Day Time Type Printer Backup Report File
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For example, Monday through Thursday.

2. Press F2 A to open the Actions menu.

3. Press S for Schedule Backup .

A dialog box prompts you for further scheduling information.

4. Choose the type of backup you want (full or partial).

5. Type the time you want the backup to start.

It is best to schedule backups at the end of the workday when users
are no longer using the system. Also, schedule the backup for the
same time every day so users know when to expect it, and can plan
accordingly.

6. Select a backup device.

7. Select a backup printer (for backup report).

To save the backup report in a file, enter a file name, group or
account were the report will be saved.

8. Press F5 OK to schedule the backup.

When the scheduled backup starts, HP Easytime/XL sets the job and
session limits to 1 to prevent any new session or jobs from starting.

Scheduled Backup

A scheduled backup will start and complete automatically only under
the following conditions:

• A write-enabled tape is loaded.

• The tape device is configured for auto-reply. See system
configuration documentation for details.

• The files to be backed up must fit on one tape; otherwise, someone
must load the next one.

Canceling a Scheduled Backup

A scheduled backup can be canceled at any time before it starts.

1. From the Backup Management screen, select one or more scheduled
backups.

2. Press F2 A to open the Actions menu.

3. Press D for Delete Scheduled Backup .

4. Press F5 Yes to cancel the scheduled backup.

Performing Backups

In addition to performing regularly scheduled backups, a full or partial
backup can be performed whenever needed. Before starting a backup,
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send a message warning users to log off the system, for example:

Backup will begin in 10 minutes. Please finish and log off.

To perform the backup:

1. Prepare backup tapes and device.

Refer to the reference information received with the drive.

2. Load the drive.

3. Press F2 A to open the Actions menu.

4. Press F to Perform Full Backup .

Or, press P for Perform Partial Backup .

If there are active jobs and sessions a dialog box prompts you to
confirm that you want to continue. Any files currently accessed by
the active jobs and sessions will not be backed up. Press F5 Yes if you
want to continue with the backup.

Once the backup begins, HP Easytime/XL sets the job and session
limits to 1 to prevent any new sessions or jobs from starting.

CAUTION If the system is configured for auto-reply, the backup starts
immediately. Any files stored previously will be lost.

If the system is not configured for auto-reply, a dialog box prompts
for more information.

Supply the requested information and press F5 OK to continue with
the backup.

Or, press F7 Stop  to stop the backup.

During the backup process, HP Easytime/XL displays a monitoring
screen where you can check the progress of the backup. Do this by
pressing F5 Update Display  periodically. During the backup
process, the terminal cannot be used for anything else.

If the backup is progressing correctly, the monitoring screen displays
the percent complete, for example:

STORE OPERATION IS 25% COMPLETE.

When the backup is finished, the following message is displayed:

Backup finished successfully. See report ETBUPLST.

When this message is displayed, the backup process is finished.

5. Press F8 Close  to close the monitoring screen.

Stopping the Backup Process

• Press F7 Stop .
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• Press F5 Yes to confirm.

• Press F8 Close to close the monitoring screen and go back to Backup
Management.

It can take several minutes for the backup process to stop.

Verifying Backup Information

HP Easytime/XL prints a backup report listing every file backed up,
and every file the system was not able to back up. Check this report to
verify that all files have been successfully saved.

The name of the report file is ETBUPLST. This report can be viewed on
the Print File Management screen. This file can be quite large and so
the status in ON HOLD. Take the file off hold if you want to print it.

Setting Backup Options

Special default options can be specified when backing up the files. If you
are the system administrator, you can save these options permanently.

1. From the Backup Management screen, press F2 O to open the
Options menu.

2. Press B for Set Backup Options .

A dialog box prompts for more information.

3. Type a file name, group, and account for the backup report. If the file
does not exist, HP Easytime/XL creates it.

4. If you are the system administrator, you can press F6 Save  to save
this setting permanently

Or, press F5 OK to save the backup options for this session only.

Setting Backup Device

Specify the backup device to be used when performing backups, or
storing and restoring files. If you are the system administrator, you can
save these options permanently.

1. From the Backup Management screen, press F2 O to open the
Options menu.

2. Press D for Set Backup Device .

A dialog box displays a list of available backup devices.

3. Select a device from the list.

4. If you are the system administrator, you can press F6 Save to save
this setting permanently.

Or, press F5 OK to save the backup device for this session only.
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Console Messages
You can monitor the system from the Console Management screen and
respond to requests from the system. The menus at the top of the
Console Management screen contain all of the options necessary for
managing console messages and requests, including the following
tasks:

• Replying to requests

• Printing messages and requests

• Displaying console messages

Accessing Console Management

1. Move the cursor to Console Management  on the Main menu.

2. Press either the F3, Return  key or the Spacebar .

The Console Management screen displays the following information:

• Messages from the system

• Requests that require a response

• Time the request or message was sent

• Creator of the request

Figure 3-7 illustrates the Console Management screen.

Figure 3-7 Console Management

Field
Help

Fast
Select

Select To/From
Menu

Update
Display

Close

HP Easytime/XL Console Management

Actions Main View Options Exit Help
Display last updated at 10:10 AM

Time Creator Message

9:51 AM MGR.FINANCE LOGOFF ON JOBTAPE (10)
9:51 AM PAT.FINANCNE LOGON FOR: “PAT.FINANCE.PUB” ON TERM (100)
9:57 AM MGR.SYS LOGON FOR: “MGR.SYS.PUB” ON JOBTAPE (10)

10:00 AM TAPE (7) NOT READY
10:01 AM LABELED VOLUME LOADED ON TAPE (7)
10:02 AM PAT.FINANCE LOGOFF ON TERM (100)
10:05 AM MARK.FINANCE LOIGOFF ON TERM (101)

10:02 AM MGR.SYS LOAD “PATTAPE” ON TAPE (7)
10:03 AM LP (6) FORMS ALIGNED OK (Y/N) ?

Time Creator Request

Messages

Requests
Chapter 3 75



HP Easytime/XL Tasks
Console Messages
To move between the requests and messages.

• Press Tab key.

Replying to Requests

Some tasks, like backing up the system or storing a file on tape, require
additional user input after they are started. HP Easytime/XL prompts
you to load or remove tapes as needed. These prompts are called
requests.

1. Select one request from the Console Management screen.

2. Press F2 A to open the Actions menu.

3. Press R for Reply to Request .

A dialog box displays the system request and prompts for a reply.

4. Read the request and follow the instructions on the screen.

5. Press F5 OK to continue.

Or, press F8 Cancel  to postpone the reply until later.

NOTE Some request dialog boxes have a Stop option. If you press F7 Stop , you
abort a task in progress (for example, backing up the system, or storing
a file on tape) and delete the request from the system.

Printing Messages and Requests

1. Press F2 A to open the Actions menu.

2. Press P for Print Requests/Messages .

All messages and requests will be printed on the HP Easytime/XL
printer. The name of the print file is ETONLST.
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Displaying Console Messages

Log on to HP Easytime/XL and go to Console Management, you can
read the last 1,000 messages the system sent and any pending requests.

If you do not want to see all messages and requests on the system, you
can restrict your view to a particular set of messages and requests, for
example, those for a specific user or account.

1. Press F2 V to open the View menu.

2. Press V for Set View .

A dialog box prompts you to type a set of messages.

3. Type a set of user names and accounts. Wildcard characters can be
used to define the set.

4. Press F OK to display the new view.

Only those messages specified are displayed on the screen. This new
view will last until exiting HP Easytime/XL, or until the view is
changed again.

Resetting View

If a view of messages and requests has been set, you can quickly reset it
to view all messages and requests on the system with this task.

1. Press F2 V to open the View menu.

2. Press R for Reset View .
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Customizing HP Easytime/XL
The system manager can use the setup program to customize
HP Easytime/XL. This program is optional. HP Easytime/XL arrives
already set up. It can be used as it is, or can be changed to meet
particular needs.

This section explains how to use the setup program, including the
following tasks:

• Starting setup program

• Disabling and enabling functions

• Setting defaults

• Startup screens

Starting Setup Program

System manager capabilities are needed to customize HP Easytime/XL
with the setup program.

1. Log on to the system as MANAGER.SYS.

2. From the system prompt, type:

:RUN ETSETUP.PUB.SYS Return

The HP Easytime/XL Setup screen shown in Figure 3-8 is displayed.

Figure 3-8 Setup Screen

Field
Help

Fast
Select

Select To/From
Menu Bar

Save Exit
Setup

HP Easytime/XL Setup

Actions Exit Help

Functions User access

Print File Management enabled
File Management enabled
Job Management enabled
Session Management enabled
Console Management enabled

Backup Defaults

Job file to be started before backup:
after  backup:

Console Defaults

Messages will be displayed in HP Easytime/XL only.
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Disabling Functions

HP Easytime/XL comes with all functions enabled and any user can
access them. The setup screen shown in Figure 3-9 displays a list box
containing all the HP Easytime/XL functions.

You can disable any function that you do not want user to access.

1. aaaSelect one or more functions.

2. Press F2 A to open the Actions menu.

3. Press D for Disable Function .

Figure 3-9 Actions Menu

Enabling Functions

The setup program can be used at any time to enable functions that
have been disabled.

1. Select one or more functions.

2. Press F2 A to open the Actions menu.

3. Press E for Enable Function .

Defaults for Scheduled Backups

With this task you can specify a job to run immediately before a
scheduled backup which deletes (aborts) active sessions and specific
jobs. After the backup, you can run another job that restarts the jobs
and processes that were previously stopped.

Field
Help

Fast
Select

Select To/From
Menu Bar

Save Exit
Setup

HP Easytime/XL Setup

Actions Exit Help

Functions User access

Print File Management enabled
File Management enabled
Job Management enabled
Session Management enabled
Console Management enabled

Backup Defaults

Job file to be started before backup:
after  backup:

Console Defaults

Messages will be displayed in HP Easytime/XL only.

Enable Function
Disable Function
Use as Startup

Set Backup Defaults...
Set Console Defaults...

Save Setup File

Disable Function

Actions
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1. Press F2 A to open the Actions menu.

2. Press B for Set Backup Defaults .

A dialog box prompts for more information.

3. Type the file name, group, and account of the job to start before the
scheduled backup.

Use the Tab key to move from field to field.

4. Type the file name, group, and account of the job to start after the
scheduled backup.

5. Press F5 OK to set the backup defaults.

The backup defaults selected are displayed on the HP Easytime/XL
Setup screen.

Defaults for Console Messages

With HP Easytime/XL, you do not need a dedicated terminal to view
and respond to console messages. You can monitor console messages
from the Console Management screen within HP Easytime/XL.

Display messages and requests on both the system console and in
HP Easytime/XL, or in HP Easytime/XL only, refer to Figure 3-10.

Figure 3-10 Console Defaults

1. Press F2 A to open the Actions menu.

2. Press C for Set Console Defaults .

3. Select the option wanted.

An asterisk (*) marks the selected option.

If you choose to display messages on both the system console and in
HP Easytime/XL, you will not be able to use the system console for
any other application, including HP Easytime/XL.

4. Press F5 OK to set the console default.

The option selected is displayed on the HP Easytime/XL Setup
screen.

Choose one of the following options:

< >

<*> Display messages in HP Easytime/XL only.

Console Defaults

[ Help ] [ Cancel ][ OK ]

Display messages on the System Console and in HP Easytime/XL
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Choosing a Startup Screen

HP Easytime/XL is configured to display the Main menu when started.
This can be changed to display a different screen, for example, Print
File Management, when starting the program.

1. Select one function

2. Press F2 A to open the Actions menu.

3. Press U for Use as Startup .

This screen is marked (Startup ) on the HP Easytime/XL Setup
screen.

Canceling a Startup Screen

If you choose a screen as the startup screen for HP Easytime/XL you
can cancel it by enabling the function again.

1. Select the function marked (Startup ).

2. Press F2 A to open the Actions menu.

3. Press E for Enable Function .

This screen is no longer the startup screen and the Main menu will
be used instead.

Saving Setup

After you have completed customizing HP Easytime/XL, you must save
the setup file.

1. Press F2 A to open the Actions menu.

2. Press S for Save Setup File .

Exiting Setup Program

1. Press F8 Exit  to exit HP Easytime/XL Setup.

2. Press F5 Yes to confirm and exit.
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Solving Problems
This section lists problems that my be encountered when working with
HP Easytime/XL, possible causes for the problem, and steps for
recovery.

Print File Problems

MESSAGE: Print file is not printing.

CAUSE: Print file needs a form (or standard paper) loaded.

ACTION:  Check the Print File Management screen for the name of the
form and load it on the printer. Perform the task Load Form  to inform
the system that it has been loaded.

CAUSE: Form needs alignment.

ACTION: Check to see that the form is correctly aligned and perform the
task Align Form  form the Print File Management screen.

CAUSE: Print file has been put on hold.

ACTION:  Perform the task Take off Hold  from the Print File
Management screen.

Printer Problems

MESSAGE: Nothing is printing on a printer.

CAUSE: Printer is not ready

ACTION:  Check the printer to make sure that it is plugged in, switched
on, and online. Check for a paper jam, or check if paper need to be
loaded.

CAUSE: Printer is not enabled.

ACTION:  The system administrator should enable the printer.

CAUSE: Printer outfence set too high.

ACTION:  The system administrator should check the outfence.
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Session Problems

MESSAGE: Terminal is not responding.

CAUSE: Various causes.

ACTION:  Delete session and logon again.

ACTION:  Press Shift  + Reset  keys.

MESSAGE: Screen display is corrupted.

CAUSE: Communication problem between terminal and computer.

ACTION:  Press Clear display  key.

MESSAGE: User cannot type data in a field.

CAUSE: Input field is full and you are in insert mode.

ACTION:  Press Insert char  key again to change to overwrite mode.
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4 HP Easytime/XL Reference
This chapter provides reference information about the following topics:

• Requests and messages from the system

• Cursor movement, editing, selection, and function keys

• Field definitions for each screen

• HP Easytime/XL options

• Wildcard characters
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Requests and Messages
This section provides a list of requests and messages that may be
encountered when working with HP Easytime/XL. The three kinds of
messages displayed in HP Easytime/XL are:

• Requests prompting for more information.

• Messages resulting from an error (requires a correction action).

• Messages about what is happening on the system.

Messages and requests are displayed on the Console Management
screen shown in Figure 4-1.

Figure 4-1 Console Management Screen

Field
Help

Fast
Select

Select To/From
Menu Bar

Update
Display

Close

HP Easytime/XL Console Management

Actions Main View Options Exit Help
Display last updated at 10:10 AM

Time Creator Message

9:51 AM MGR.FINANCE LOGOFF ON JOBTAPE (10)
9:51 AM PAT.FINANCNE LOGON FOR: “PAT.FINANCE.PUB” ON TERM (100)
9:57 AM MGR.SYS LOGON FOR: “MGR.SYS.PUB” ON JOBTAPE (10)

10:00 AM TAPE (7) NOT READY
10:01 AM LABELED VOLUME LOADED ON TAPE (7)
10:02 AM PAT.FINANCE LOGOFF ON TERM (100)
10:05 AM MARK.FINANCE LOIGOFF ON TERM (101)

10:02 AM MGR.SYS LOAD “PATTAPE” ON TAPE (7)
10:03 AM LP (6) FORMS ALIGNED OK (Y/N) ?

Time Creator Request
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Responding to Requests

Requests are messages from the system that prompt you to first do
something, and then confirm the actions by replying, either from the
Console Management screen, or from a dialog box. Respond
immediately when there is a request pending on the system. A process
or task, such as a backup, cannot continue until the required
information is supplied.

This section provides a list of common requests, causes for the request,
and the required actions:

REQUEST: FORMS ALIGNED OK (Y/N)? device (ldev n)

CAUSE: This message occurs when a form has been loaded.

ACTION:  Check that form is correctly aligned and perform the task.
Align Form  from the Print File Management screen.

REQUEST: IS PAPER AT TOP OF FORM (Y/N)? device (ldev n)

CAUSE: This message occurs at the beginning of a print job.

ACTION: Check that the paper is at the top of form and perform the task
Align Form  from the Print File Management screen.

REQUEST: IS WRITE ENABLED (Y/N)? device (ldev n)

CAUSE: Message occurs during a backup or when storing files to tape.

ACTION:  Confirm that the tape is enabled and reply to the request.
Information can only be stored on tape that is write enabled.

REQUEST: LOAD tape ON device (ldev n)

CAUSE: This message occurs during a backup, store, or restore process
when a tape is loaded.

ACTION:  Load the tape indicated in the correct tape drive and reply to
the request.

REQUEST: SELECT DEVICE NO. OF CLASS classname ON WHICH
YOU LOADED tape.

CAUSE: This request occurs during a backup, store, or restore process
when a tape is loaded.

ACTION:  Load the tape indicated in the correct tape drive and reply to
the request.

REQUEST: SP #ldev n IS #job number, file name ON device (ldev n)
(Y/N)?

CAUSE: This request occurs when a print file requires a form or
standard paper to be loaded.

ACTION: Check the Print File Management screen for the kind of paper
required and perform the task Load Form .
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Responding to Messages

Monitor messages to keep informed about activity on the system, for
example, users or jobs logging on and off, disk storage, or other resource
usage. Some messages are caused by an error and require a corrective
action.

This section provides a list of system messages. When the message is
caused by an error, possible causes for the error, and suggestions for
recovery, are also included.

MESSAGE: IS NOT WRITE ENABLED. device (ldev n)

CAUSE: This message occurs during a backup, or when storing or
restoring files. It indicates that the tape is not write enabled.

ACTION:  Enable the tape for writing.

MESSAGE: MUST BE ONLINE BEFORE REPLYING. device (ldev n)

CAUSE: This message occurs if the tape drive is not online during a
backup, or when storing or restoring files.

ACTION:  Set the tape drive online.

MESSAGE: NOT READY. device (ldev n)

CAUSE: This message occurs when there is a problem with a printer or
tape drive.

ACTION:  Check the device to make sure that it is plugged in, powered
on, and online. If the device is a printer, check for a paper jam and that
it is not out of paper.

MESSAGE: FORMS ON device (ldev n): forms message.

CAUSE: This message occurs when a print file requires a form.

ACTION:  Check the Print File Management screen for the kind of form
required and perform the task Load Form .

MESSAGE: LOGOFF ON. device (ldev n)

CAUSE: User or job indicated has logged off this device.

ACTION:  No action required.

MESSAGE: LOGON FOR: user,group.account ON device (ldev n)

CAUSE: User or job indicated has logged on to this device.

ACTION:  Load the next tape in the tape drive.

MESSAGE: LOAD MEDIA media n FOR RESTORE ON. device (ldev n)

CAUSE: This message occurs when restoring files from tape. Indicates
that the end of the tape has been reached.

ACTION:  Load the next tape in the tape drive.
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MESSAGE: LOAD NEXT MEDIA FOR RESTORE ON. device (ldev n)

CAUSE: This message occurs when restoring files from tape. Indicates
that the end of the tape has been reached.

ACTION:  Load the next tape in the tape drive.

MESSAGE: LOAD MEDIA media n FOR STORE ON. device (ldev n)

CAUSE: This message occurs when restoring files from tape. Indicates
that the end of the tape has been reached.

ACTION:  Load the next tape in the tape drive.

MESSAGE: LOAD NEXT MEDIA FOR STORE ON. device (ldev n)

CAUSE: This message occurs during backup or when storing files to
tape. Indicates that the end of the tape has been reached.

ACTION:  Load the next tape in the tape drive.

MESSAGE: STANDARD FORMS ON device (ldev n): forms message.

CAUSE: This message occurs when a print file requires a standard
paper (after a form has printed).

ACTION: Load standard paper in the printer and perform the task Load
Form from the Print File Management screen.

MESSAGE: STORE OPERATION IS number % COMPLETE

CAUSE: This message occurs during a scheduled backup and indicates
the current status of the backup process.

ACTION:  No action required.

MESSAGE: UNLABELED VOLUME LOADED ON. device (ldev n)

CAUSE: This message occurs when an unlabeled tape is loaded in the
tape drive.

ACTION:  No action required.

MESSAGE: VOLUME WITH LABEL label LOADED ON device (ldev n)

CAUSE: This message occurs during a backup, store, or restore process
when labeled tapes are used. Tape indicated is currently loaded on this
tape drive.

ACTION: No action required. HP Easytime/XL cannot use labeled tapes.
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This section provides a way to identify the keys to use when performing
HP Easytime/XL tasks. The keys will vary depending on the kind of
terminal used.

Cursor Movement Keys

Use the following keys to move in HP Easytime/XL:

To Scroll Press these keys

Up one line ▲ key

Down one line ▼ key

Up one page Shift  + ▲ key or Scroll Up  key

Down one page Shift  + ▼ key or Scroll Down  key

Right one page Next  key

Left one page Prev  key

Top of list Home  key or (arrow pointing upper left)

Bottom of list Shift  + Home  key

To Move in a Dialog Box Press these keys

Next field Tab key

Previous field Shift  + Tab key

One character right Right arrow  key

One character left Left arrow  key

Editing Keys

Use any of the following keys to edit information on the screen.

To do this Press these keys

Go to insert mode Insert char  key

Exit insert mode Insert char  key again

Delete a character Delete char  key

Delete one character to the
left of cursor Backspace  key

Delete all characters Delete line  key

Delete all characters to the
right of the cursor Clear line  key
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Function Keys

This section describes the function keys used in HP Easytime/XL for
the many tasks that are performed. Both the function labels and keys
are listed. Not every function key is available on every screen or dialog
box. The labels change according to the dialog box or screen. However, a
function key label always refers to the same key wherever it appears.

Press this key Does this

Add to List F6 In a dialog box, Add to List moves the
indicated file to the list box.

Cancel F8 In a dialog box, Cancel  cancels the
tasks and closes the dialog box.

Close F8 On a screen, Close  closes the active
screen and displays the previous one.

In a help window, Close  closes the
window.

Delete from List F7 In a dialog box, Delete from List
deletes the selected file from the list
box.

Fast Select F2 On a screen, Fast Select (and then an
underlined letter) opens the
corresponding menu.

In a dialog box, Fast Select (and then
an underlined letter) selects and
activates a push button.

Field Help F1 In HP Easytime/XL, Field Help
displays help about the current cursor
object, for example, a data-entry field,
or a menu item.

No F8 In a confirmation box, Nocancels a task
and closes the box.

OKF5 In a dialog box, OK confirms and
completes a task, and closes the dialog
box.

Read F5 In a help window, Read displays help
information about the selected topic.

Read Next F5 In a file, Read Next  displays the
contents of the next selected file.

Save F7 In a dialog box, Save saves the selected
options.
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Select F3 In a list of values, Select  selects the
value of which the cursor rests.

In a dialog box, Select selects the push
button on which the cursor rests.

In a menu, Select  selects the menu
item on which the cursor rests.

In a list box, Select  and then / key
selects all items in the list.

Select  and then \ key cancels the
selection of all items in the list.

Stop F7 In a dialog box, Stop  stops a task in
progress, for example, a backup.

Test F6 In a dialog box (when aligning forms),
Test  prints a test line.

To/From Menu Bar F4 In HP Easytime/XL, To/From Menu
Bar  moves the cursor to or from the
menu bar.

Update Display F5 In HP Easytime/XL, Update Display
updates the terminal display with the
most current data. The time of the last
update is always displayed on the
status line of the screen.

Yes F5 In a confirmation box, Yes confirms and
completes a task, and closes the box.
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Field Definitions
This section illustrates and provides field names and definitions for the
following HP Easytime/XL screens:

• Session Management

• File Management

• Print File Management

• Printer Management

• Job Management

• Backup Management

• Console management
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Session Management

This section illustrates and defines the fields that are displayed on the
Session Management screen shown in Figure 4-2, and that is
encountered when performing Session Management tasks.

Figure 4-2 Session Management Screen

Field Name Means this

Session Name Name of the session. This can be
specified when logging on.

User Name of the user who started the
session.

Account Logon account of the user who started
the session.

Program Name of the program that the session
is running (if there is one).

Start Date/Time Date and time when a session started.

Field
Help

Fast
Select

Select To/From
Menu Bar

Update
Display

Close

HP Easytime/XL Session Management

Actions Main View Options Exit Help
Display last updated at 9:46 AM

Session User Account Program Start Date/Time
Name

ADMIN DAVID FINANCE EASYTIME 04/24/01 3:07 PM
ROSS ROSS PAYROLL EASYTIME 04/24/01 4:10 PM (YOUR SESSION)
PAT PAT PAYROLL HPEDIT 04/25/01 8:22 AM
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File Management

This section illustrates and defines the fields that are displayed on the
File Management screen and that are encountered when performing
File Management tasks as shown in Figure 4-3.

Figure 4-3 File Management Screen

Field Name Means this

File Name Name of the file. A file name can
contain a maximum of eight
alphanumeric characters and must
begin with a letter.

Group Group where the file is located. Files
located in the PUB group are usually
files that all users share. Files in other
groups are often private files for users
in the group only.

Account Account where the file is located.

Code Indicates the kind of file, for example,
ASCII or WDOC.

Status Shows current file security (whether
file is secured or released).

Size Shows size of the file in kilobytes. If a
file is smaller than one kilobyte, <1 is
displayed.

Field
Help

Fast
Select

Select To/From
Menu Bar

Update
Display

Close

HP Easytime/XL File Management

Actions Main View Options Exit Help
Display last updated at 9:36 AM

File Name Group Account Code Status Size(KByte)

BUDGET PUB PAYROLL WDOC SECURED 24
LETTER PUB PAYROLL ASCII SECURED 7
OFFERS PUB PAYROLL ASCII SECURED 26
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Print File Management

This section illustrates and defines fields that are displayed on the
Print File Management screen shown in Figure 4-4 and that are
encountered when performing Print File Management tasks.

Figure 4-4 Print File Management Screen

Field Name Means this

Print File Name Name of the file to be printed.

User User who created the print file.

Account Logon account of the user who created
the print file.

Printer The identification name or number of
the printer where the files will be
printed.

Status The status of the print file.

CREATE The print file is being created.

PRINTING The print file is currently printing.

READY The print file is ready (waiting) to
print.

ON HOLD The print file is on hold. Cannot print
until taken off hold.

LOAD FORM A form is required and must be loaded
before printing can continue.

Field
Help

Fast
Select

Select To/From
Menu Bar

Update
Display

T Close

HP Easytime/XL Print File Management

Actions Main View Options Exit Help
Display last updated at 9:58 AM

Print User Account Printer Status No. of Length Forms
File Name Copies  (pages)

REPORT MGR SYS LP PRINTING 1 ~ 1
CHECKS DAVID FINANCE LP READY 2 ~ 4
BUSPLN GORDON MKT LP READY 1 ~12
BUDGET CAROL PAYROLL LP READY 1 ~ 4
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ALIGN FORM A form has been loaded and requires
alignment.

PROBLEM There is a problem with the printer or
with a print file. Check to make sure
the printer is switched on, or for a
paper jam.

UNKNOWN Cause of the problem is unknown.
Contact your system administrator for
assistance.

No. of Copies Shows number of copies that will be
printed.

Length Shows the approximate length (in
pages) of each print file.

Forms Indicates the name of the form, if one is
required.
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Printer Management

This section defines the fields that are displayed on the Printer
Management screen shown in Figure 4-5, and that can be encountered
when performing Printer Management tasks.

Figure 4-5 Printer Management Screen

Field Name Means this

Printer Identification name of the printer. Usually, each printer
has one name assigned to it. In some cases, several
printers may be grouped together under one name.

Status This is the printer status.

ENABLED The system administrator has enabled the printer. It is
available for printing.

DISABLED The system administrator has disabled the printer. The
print files will not print until the printer is enabled.

UNKNOWN Cause of problem is unknown. Contact the system
administrator for assistance.

Outfence The outfence is a number assigned to each printer on
the system by the system administrator. The outfence
is the minimum priority a print file must exceed in
order to print. The outfence can be any value from 1 to
14. If the outfence is set at 5, for example, only those
print files with a priority of 6 or higher can print. By
adjusting the outfence higher or lower, the system
administrator can control printing on specific printers.

Field
Help

Fast
Select

Select To/From
Menu Bar

Update
Display

Close

HP Easytime/XL Printer Management

Actions Main View Options Exit He
Display last updated at 10:16 AM

Printer Status Outfence

LASERJET ENABLED 8
LP ENABLED 12
98 Chapter 4



HP Easytime/XL Reference
Field Definitions
Job Management

This section defines the fields that are displayed on the Job
Management screen shown in Figure 4-6, and that are encountered
when performing Job Management tasks.

Figure 4-6 Job Management Screen

Field Name Means this

Job Name An identification name given to each job when it is
started or scheduled.

User User name under which the job is logged on.

Account Account under which the job is logged on.

Program The name of the program that the job is running
(if there is one).

Status The status of the job.

ACTIVE The job is running.

READY The job is ready (waiting) to run.

SCHED The job is scheduled to run at a later date and time.

ON HOLD The job has been put on hold. It will not run until it is
taken off hold.

SUSPEND The job has been suspended (interrupted). It will not
run until processing has been resumed.

Start Date/Time Data and time a job started, or is scheduled to
start.

Field
Help

Fast
Select

Select To/From
Menu Bar

Update
Display

Close

HP Easytime/XL Job Management

Actions Main View Options Exit Help
Display last updated at 11:20 AM

Job Name User Account Program Status Start Date/Time

REPORTS PAT FINANCE CI ACTIVE 04/24/01 10:21 AM
UPDATE KURT MKTG CI ACTIVE 04/24/01 11:18 AM
MONTHEND CHRIS TESTING CI READY 04/25/01 11:40 AM
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Backup Management

This section defines the fields that are displayed on the Backup
Management screen shown in Figure 4-7 and that are encountered
when performing Backup Management tasks.

Figure 4-7 Backup Management Screen

Field Name Means this

Type Type of backup (Full or Partial).

Date Date the backup was performed.

No. of Tapes Number of tapes needed to complete
the backup.

Device Tape drive on which the backup was
performed.

Time Needed Time needed to complete the backup.

Files Stored Number of files stored during the
backup.

Day Day of the week a backup is scheduled.

Time Time a backup is scheduled.

Printer Printer where the backup report will be
printed.

Backup Report File Name of the file for the backup report.

Field
Help

Fast
Select

Select To/From
Menu Bar

Update
Display

Close

HP Easytime/XL Backup Management

Actions Main View Options Exit Help
Display last updated at 10:05 AM

Latest Backups:
Type Date No. of Tapes Device Time needed Files stored

PARTIAL 04/08/01 1 TAPE 7:02 78
PARTIAL 04/09/01 1 TAPE 13:16 159
PARTIAL 04/10/01 2 TAPE 24:10 976
PARTIAL 04/11/01 2 TAPE 30:26 1271
FULL 04/12/01 5 TAPE 1:22:17 6782

MONDAY 9:00 PM PARTIAL LP MON.BCK.SYS
TUESDAY 9:00 PM PARTIAL LP TUE.BCK.SYS
WEDNESDAY 9:00 PM PARTIAL LP WED.BCK.SYS
THURSDAY 9:00 PM PARTIAL LP THU.BCK.SYS
FRIDAY 9:00 PM FULL LP FRI.BCK.SYS

Scheduled Backups:
Day Time Type Printer Backup Report File
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Console Management

This section defines the fields that are displayed on the Console
Management screen shown in Figure 4-8 and that are encountered
when performing Console Management tasks.

Figure 4-8 Console Management Screen

Field Name Means this

Time Time when the system sent the message or request.

Creator The name and logon account of the user whose session
or job created the message or request. If a message is
sent from the system, the creator field is blank.

Message Messages about what is happening on the system.

Request Requests from the system that require a response.

Field
Help

Fast
Select

Select To/From
Menu Bar

Update
Display

Close

HP Easytime/XL Console Management

Actions Main View Options Exit Help
Display last updated at 10:10 AM

Time Creator Message

9:51 AM MGR.FINANCE LOGOFF ON JOBTAPE (10)
9:51 AM PAT.FINANCNE LOGON FOR: “PAT.FINANCE.PUB” ON TERM (100)
9:57 AM MGR.SYS LOGON FOR: “MGR.SYS.PUB” ON JOBTAPE (10)

10:00 AM TAPE (7) NOT READY
10:01 AM LABELED VOLUME LOADED ON TAPE (7)
10:02 AM PAT.FINANCE LOGOFF ON TERM (100)
10:05 AM MARK.FINANCE LOIGOFF ON TERM (101)

10:02 AM MGR.SYS LOAD “PATTAPE” ON TAPE (7)
10:03 AM LP (6) FORMS ALIGNED OK (Y/N) ?

Time Creator Request
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HP Easytime/XL Options
With the Options menu, a set of defaults can be set that apply when
backing up the system, storing and restoring files, or printing:

• HP Easytime/XL printer

• Store options

• Restore options

• Backup device

The system administrator can save the option settings permanently.
Unless saved, options are valid until exiting HP Easytime/XL, or the
settings are changed.

Printer Option

Access the Set Printer  option from the Options menu on any
HP Easytime/XL screen, refer to Figure 4-9.

Figure 4-9 Set Printer

Set Printer

Sets the default printer for all printing initiated in
HP Easytime/XL, for example, print files, listings of
system errors, or backup reports.

Select the HP Easytime/XL printer and choose OK.

 LP

Set Printer

[ Cancel ]

LASERJET

[ Save ][ OK ][ Help ]
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Store Options

Access Store Options  from the Options menu on the File
Management screen. Refer to Figure 4-10, for options that can be set for
storing files to tape:

• Save the store report on disk.

• Store directory information with files.

Figure 4-10 Store Options

Store Report

Specify a file name, group, and account for the store
report. This report is saved on disk.

Store directory information

This option creates a tape with all the files that were
selected, as well as their directory information
(accounts, groups, and users).

Store Report

 Write report to File Name:
Group:
Account:

Store Options

[ Cancel ][ Save ][ OK ][ Help ]

[ ] Produce a tape which is compatible to MPE V/E
[ ] Store directory information.

You can choose one of the following options.
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Restore Options

Access Restore Options  from the Options menu on the File
Management and Backup Management screens. Refer to Figure 4-11,
for options that can be set for restoring files from tape:

• Save the store report on disk.

• Do not overwrite files on disk.

• Create account, groups, and users if needed.

• Restore files to logon group and account.

• Restore directory information with files.

Figure 4-11 Restore Options

Restore Report

Specify a file name, group, and account for the restore
report. This report is saved on disk.

Do not overwrite files on disk.

This option prevents overwriting of files on disk. If a file
on tape has the same name as a file on disk, it is not
restored.

Create accounts, groups, users as needed.

This option creates accounts, groups, and users if they
are needed for the files being restored.

Restore Report

 Write report to File Name:
Group:
Account:

Restore Options

[ Cancel ][ Save ][ OK ][ Help ]

[ ] Do not overwrite files on disk.
[ ] Create accounts, groups, users as needed.
[ ] Restore files to logon group and account.
[ ] Restore directory information.

Restore options.
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Restore files to logon group and account.

This option restores all the selected files to the logon
group and account.

Restore directory information

This option restores directory information (accounts,
groups, users) to disk, along with selected files.

Backup Device Option

Access the Set Backup Device  option, refer to Figure 4-12, from the
Options menu on the File Management and Backup Management
screens.

Figure 4-12 Set Backup Device

Set Backup Device

Sets the backup device for backups, and for storing and
restoring files.

Select the device to be used for backup, store, and
restore processes and choose OK.

 TAPE

Set Backup Device

[ Cancel ]

DAT

[ Save ][ OK ][ Help ]
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Backup Options

Access the Backup Options , refer to Figure 4-13, from the Options
menu on the File Management and Backup Management screens.

Figure 4-13 Backup Options

Backup Options

Specify a file name, group, and account for the backup
report. This report is saved on disk.

Write report to File Name:
Group:
Account:

Backup Options

[ Cancel ][ Save ][ OK ][ Help ]

Backup Report
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Wildcard Characters
Wildcard characters represent groups of other characters. Use them in
place of actual characters when specifying any of the following:

• File names

• User names

• Account names

• Group names

The following wildcard characters can be used in HP Easytime/XL:

This character Represents

@ Any number of alphanumeric
character. Alone it means “all.”

? One alphanumeric character.

# One number.

Examples:

Display all the file names.

File Name: @

Display all file names beginning with “T”.

File Name: T@

Display all file names beginning with “T” followed by four numbers.

File Name: T####

Display all files for group “FINANCE”

File Name: @

Group: FINANCE

Account: @
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Limit No. of Jobs, 68
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Restore, 48
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Schedule Backup, 72
Secure, 52
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Set Backup Defaults, 80
Set Console Defaults, 80
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Set Outfence, 62
Start, 66
Store, 46
Suspend, 67
Take off Hold, 56, 67
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B
backup device, 74
Backup Management, 70, 72
Backup Management tasks, 100
backups, 70

Full, 71
Partial, 71
scheduling, 71

basic skills, 37

C
changing system administrator password, 36
Console Management, 75
Console Management tasks, 101
console messages, 80
context sensitive help, 23
cursor keys, 31, 90
customize HP Easytime/XL, 78

D
definitions, 93
Delete file, 38
dialog box, 34

canceling, 34
closing, 34
moving, 34

dialog boxes, 33
Disable HP Easytime/XL, 17

E
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ETBUPLST, 74
ETLEARN, 37
ETONLST, 76
ETRSTLST, 49
ETSTLST, 47

F
Field help, 23
fields, 33
File Management, 44
File Management tasks, 95
Files

deleting, 49
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moving, 50
printing, 54
sorting, 53

files, 44
function keys, 91

G
group, 46

H
help, 23
help key, 24
Help menu, 23
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help topic, 24
HP Easytime/XL
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enabling, 17
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language settings, 16
log off, 22
log on, 20
Main menu, 25
menu conventions, 30
menus, 28
operating modes, 35
options, 102
passwords, 35
screens, 26
Setup screen, 80
starting, 20

I
interrupt printing, 58

J
Job Management, 64
Job Management tasks, 99
job queue, 66
jobfence, 68
Jobs

starting, 66
status, 65

jobs, 64

K
Keys

cursor keys, 90
editing keys, 90
function keys, 91

keys, 90

L
LANGINST, 16
LANGINST dialog, 16
LANGINST utility, 16
list box, 31
load forms, 58
localized version, 16
localized versions

English, 16
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German, 16
Japanese, 16
Spanish, 16

lockword, 50
logon, 20
logon identity, 20

M
Main menu, 20, 25, 40, 81

Backup Management, 70
Change Administrator Password, 36
Close, 21, 37
Console Management, 75
Disable HP Easytime/XL, 17
File Management, 37, 44
Job Management, 65
Print File Management, 55
Printer Management, 61
Session Management, 40
Switch to System Administrator, 35
Switch to User, 36

MANAGER.SYS, 17
menu

closing, 29
item, 29
opening, 28

menus, 28
messages, 86
monitor printing status, 55
moving files, 50
MPE/iX operating system, 21
MPE/iX security, 52

O
opening a menu, 28
operating modes, 35

system administrator mode, 35
user mode, 35

options, 102
Options menu, 102

Backup Options, 106
Restore Options, 104
Set Backup Device, 74, 105
Set Backup Options, 74
Set Printer, 45, 63, 102
Set Restore Options, 49
Set Store Options, 47
Store Options, 103

outfence, 61, 62
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change printers, 58
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put on hold, 56
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take off hold, 56

Print File Management, 54, 55
Print File Management tasks, 96
Printer Management, 61
Printer Management tasks, 98
printer status, 62
printing, 38
problems, 82
public group, 37
Put on Hold, 58

Q
queued, 54

R
rename files, 50
requests, 86
restore, 48
restore files, 48

S
screen parts, 27

function keys, 27
list box, 27
menu bar, 27
message line, 27
status bar, 27
title bar, 27

screens, 26
scroll bar, 31
scroll bar arrows, 31
security provisions, 51
selecting

items, 31, 33
options, 34

sending messages, 42
Session Management, 40

abort a session, 41
delete a session, 41

Session Management tasks, 40, 94

sessions
sorting, 43

Setup screen, 80
solving problems, 82
sorted, 43
sorting, 43
status field, 55
stop printing, 58
system administrator mode, 35
system administrator password, 35

changing, 35, 36

T
tasks, 15

Backup Management, 100
Console Management, 101
File Management, 95
Job Management, 99
Print File Management, 96
Printer Management, 98
Session Management, 94

U
Update Display, 47, 48, 73
user mode, 35, 36
Utility

LANGINST, 16

V
View menu, 42, 43

Reset View, 43, 52, 59, 68, 77
Set View, 42, 52, 59, 68, 77
Sort, 60
Sort by, 69
sorting, 53

W
wildcard characters, 42, 52, 107
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